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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground.

The TReK HPEG application provides the capability to access the Huntsville Operations
Support Center (HOSC) Payload Ethernet Gateway (HPEG) service.

1.1 Getting Started

Start with the Introduction which provides an application overview. Next, try the Quick
Start Guides for “How Tos” for common functions. For help with details, reference the
Details section. See the FAQ and Troubleshooting section for helpful hints and solutions
to the common “‘gotchas”.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK
software, please contact us for technical assistance:

TReK Help Desk E-Mail, Phone & Fax:

E-Mail: trek.help@nasa.gov
Telephone:  256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time)
Fax: 256-544-9353

If you call the TReK Help Desk and you get a recording please leave a message and
someone will return your call. E-mail is the preferred contact method for help. The e-
mail message is automatically forwarded to the TReK developers and helps cut the
response time. The HOSC Help Desk (256-544-5066) can provide assistance as needed
and is available 24x7.

3 Introduction

The TReK HPEG application provides the capability to access the Huntsville Operations
Support Center (HOSC) Payload Ethernet Gateway (HPEG) service. The HPEG service
provides access to payloads onboard the International Space Station (ISS) using standard
network protocols and services. Services supported include:

Ping over ICMP

Hypertext Transfer Protocol Secure (https) over TCP on port 443
Remote Desktop (rdp) over TCP on port 3389

Secure Shell (ssh) over TCP on port 22

CCSDS File Delivery Protocol (cfdp) over UDP on port 4560

YVVVVY
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Delay Tolerant Network (dtn) over TCP on a configured port

Note: In the event this list does not match the Payload to Generic User Interface
Definition Document (PGUIDD) SSP 50305, the information in the PGUIDD takes
precedent.

Access to these services is based on HOSC account privileges.

The general sequence of events when using HPEG is as follows:

VVVVY VYV

>

Establish VPN session with HOSC.

Establish a Login Session with the HOSC using the TReK HOSC Login
application.

Start the TReK HPEG application.

Push the Configure button to configure the application.

Push the Activate button to activate the HPEG service.

Once the HPEG service is active, starta session with your destination (payload).
Use the Ground Proxy IP address returned to communicate with your payload
using other products such as the TReK CFDP application, Remote Desktop, a
console command line to ssh, etc.

When finished Deactivate and EXxit.

The interface between the TReK HPEG application and the HOSC is shown in Figure 1.

Huntsville Operations | HPEG Communication
Support Center (HOSC)

TReK HPEG
< > Application
(trek_hpeg)

Figure 1 TReK HPEG/HOSC Communication

Figure 2 shows the standard IP communication that is possible between ground
applications and flight applications once HPEG services have been started.

1SS Payload Ground Application
Application _ Standard IP Protocols PP
Onboard 155 B - (ssh, ping, etc)

Figure 2 Standard IP Communication
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4 Overview of the User Interface

4.1 Main Window

The main window is shown in Figure 3. The Message area is a dock window that you
can float or dock. To float a dock window, use your left mouse button to click and hold
the title area while dragging the window to another area of the screen. To dock, use the
title bar to drag the dock window over the main window and drop.

.- TReK HPEG — O X
File View HPEG Options Help

Configuration: . Configure | Operational . Activate Deactivate

HPEG User: Increment:  Operational Mode:  Idle Chedk: Enable Dizable

Destination Enablement Forward Link Return Link  Location Status  Ground Proxy [P Message Space Node ID

Start Session | Stop Session

Mezzage Area (-4

Ready

Figure 3 Main Window

Configuration Toolbar
The Configuration toolbar at the top of the window provides quick access to configure
the application, activate, and deactivate the HPEG service.

HPEG Toolbar

The HPEG toolbar (located under the Configuration toolbar) provides quick access to
HPEG Status and Configuration information. It also provides the capability to Enable
and Disable the HPEG Idle Check capability.

Ground Node 1D Toolbar

The Ground Node ID Toolbar (located under the HPEG toolbar when displayed) provides
quick access to the Ground Node ID. If you do not have a Ground Node ID assigned, this
toolbar will not be displayed. The Ground Node ID toolbar is only displayed when the
HPEG service is active and a Ground Node ID is in use. This toolbar will also display
Delay Tolerant Network information if you have access to this service.

HPEG

The HPEG area provides a list of “Destinations” you are authorized to access through the
HPEG. Typically you will have one destination in the list — your payload. The HPEG
area also provides “Start Session” and “Stop Session” buttons to start and stop an HPEG
session for a selected destination. If you are authorized to use the CFDP service or the
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DTN service, you will be assigned a Ground Node 1D, and your payload onboard will be
assigned a Space Node ID. These IDs correspond to CFDP Entity IDs (EIDs) needed by
the CFDP protocol and the DTN node number when using DTN. If you are authorized to
use the CFDP service or DTN service, you will be prompted to select your Ground Node
ID during HPEG activation. It is possible to have more than one Ground Node ID
assigned. In this case you will be prompted with a list and can select the Ground Node
ID you would like to use for the session. If you are not authorized to use the CFDP
service or the DTN service, you will not be prompted for a Ground Node ID and the
Space Node ID field will always be empty.

If you are authorized to use the CFDP service or DTN service, you must select a Ground
Node ID when prompted. If you select a Ground Node ID that is in use, you will be
prompted again. If all Ground Node IDs are in use, you will need to free one of the
Ground Node IDs so you can select one that is available or cancel the activation.

Message Area
The Message Area displays important information, warning and error messages. The

message area can be cleared using the View menu.

4.2 Toolbars

There are three toolbars: Configuration, HPEG and Ground Node ID. The Configuration
toolbar provides visual information about the state of the application and provides access
to common application functions. The HPEG toolbar provides HPEG Configuration and
Status information. The Ground Node ID toolbar provides access tothe Ground Node ID
selected during activation and DTN configuration information if you are authorized to
use the DTN service.

4.2.1 Configuration Toolbar

The Configuration toolbar is shown in Figure 4. It canbe used to configure the
application, activate the HPEG service, and deactivate the HPEG service.

Configuration: . Configure | Operational . Activate Deactivate

Figure 4 Configuration Toolbar

Configuration Status

When the Configuration status is black, this indicates the application has not been
configured. When the Configuration status is green, this indicates the application has
been configured and the HPEG service can be activated.

Use the Configure button to access the Configuration dialog to configure the application.

Operational Status
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When the Operational status is black, this indicates the HPEG service is inactive. When
the Operational status is purple, activation is in progress. When the Operational status is
green, this indicates the HPEG service is active. The application must be properly
configured before the Activate button will be available. The HPEG service must be
active before the Deactivate button will be available.

Use the Activate button to activate the HPEG service. This will initiate all internal
activities needed to prepare the application to support the HPEG service. If you need to
reconfigure the HPEG application, deactivate the HPEG service, and then push the
Configure button to reconfigure.

4.2.2 HPEG Toolbar

The HPEG toolbar is shown in Figure 5 and Figure 6. When the HPEG service is
Inactive, the HPEG Toolbar will not contain any HPEG Status and Configuration
information. When the HPEG service is activated, the HPEG Toolbar will display HPEG
Status and Configuration information. For details about HPEG Status and Configuration
information please reference Section 6.2. The HPEG Toolbar also provides the capability
to Enable and Disable the HPEG Idle Check. This feature is only available when the
HPEG service is active.

HPEG User:  Increment:  Operational Mode:  Idle Chedk: Enable Disable

Figure 5 HPEG Toolbar

HPEG User: Enabled Increment: 41 Operational Mode: Flight Idle Chedk: Enabled Enable Disable

Figure 6 HPEG Toolbar Populated

4.2.3 Ground Node ID Toolbar

The Ground Node ID Toolbar is shown in Figure 7. This toolbar provides quick access
to the Ground Node ID. If you do not have a Ground Node ID assigned, this toolbar will
not be displayed. The Ground Node ID toolbar is only displayed when the HPEG service
is active and a Ground Node ID is in use. If you are authorized to use the DTN service,
the Ground Node ID Toolbar will also display DTN configuration information as shown
in Figure 8.

Ground Mode ID: 345

Figure 7 Ground Node ID Toolbar
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Ground Node ID: 345 HOSC DTN Mode Number: 65535 HOSC DTN Mode IP Address: 192, 168,100,101 HOSC DTN Node Port: 2014

Figure 8 Ground Node ID Toolbar with DTN Configuration Information

4.3 Menus

The HPEG application menus are: File, View, HPEG, Options, and Help. Each of these
menus is described in more detail below.

File Menu
The File menu provides the capability to exit the application.

View Menu
The View menu provides the capability to clear the main window message area and show
and hide the main window message area.

HPEG Menu
The HPEG menu provides the capability to configure the application, activate and
deactivate the HPEG service, and show HPEG messages.

Options Menu
The Options menu provides access to the Messages dialog which can be used to display

and filter application messages. Access toadvanced settings is also available.

Help Menu
The Help menu provides access to on-line help and application version information.

5 Quick Start Guides

This section provides “How Tos” for common functions.

5.1 How to Configure the Application

The following steps describe the minimum necessary to configure the application. For
additional information and details about the Configure dialog please reference section
6.1.

1. Push the Configure button to display the Configure dialog.

2. Enter the name of an active HOSC Login Session that was created using the TReK
HOSC Login application.

3. Enter a Local IP Address.
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Note: If you are connecting to the HOSC, enter the Office Mode IP Address returned
by the HOSC VPN client in the Local IP Address field.

Enter a port number that may be used for communication between TReK and the
HOSC about HPEG.
Push the OK button to save the configuration information and exit the dialog.

Note: If your site requires Firewall Network Address Translation, use the Firewall
(NAT) tab to enter this information.

If the application is configured correctly, the Configuration status will be green.

5.2 How to Start and Stop the HPEG Service
This section describes how to start (activate) and stop (deactivate) the HPEG service.

1.

w

Before the HPEG service can be started, you must configure the application. To learn
more about this see section 5.1. The Configure status must be green before you can
start the HPEG service.

To start the HPEG service, push the Activate button on the Configuration toolbar.
The activation process will initiate a POIC login and request the HPEG service. If
this is successful the Operational status will turn green, the HPEG toolbar will be
populated with HPEG Configuration and Status information, and you will see a list of
authorized destinations in the HPEG area.

To stop the HPEG service, push the Deactivate button.

When activating or deactivating important status and/or error messages will be
displayed in the Main Window message area.

5.3 Howto Start a Session with a Destination
This section describes how to start a session with a destination.

1.
2.

The HPEG application must be configured and the HPEG service must be active.
Select an Inactive Destination in the HPEG area and push the Start Session button.
This will send a request to the POIC to start a session for the destination. If this is
successful, the destination’s Status column will show Active and the Ground Proxy IP
Address will be displayed in the Ground Proxy IP column. If you have a Space Node
ID, it will be shown in the Space Node ID column. You will also see a message in
the Message column indicating the status of your “Start Session” request.
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TReK HPEG

File View HPEG Options Help
Configuration: . Configure | Operational . Activate Deactivate

HPEG User: Enabled Increment: 41 Operational Mode: Flight Idle Cheds: Enabled Enable Disable

Ground Mode ID: 345 HOSC DTN Mode Mumber: 65535 HOSC DTN Node IP Address: 192,168, 100,101 HOSC DTM Mode Port: 2014

Destination Enablement Forward Link Return Link Location Status  Ground Proxy [P Message Space Node D
MylssPayload Enabled LOS AOS 155 Inactive 1.2.3.4
SomewhereOverTheRainbow Disabled N/A N/A lcarus  Inactive 2001

Start Session | Stop Session

Message Area g X

GMT 2019-07-22 11:51:21:644 Info: Interfacing with EHS Build Version 31.1.2

GMT 2019-07-22 11:51:22:1591 Info: Accepted connection for Socket 1.2, 156,68, 128, 186.8819. 3 IP Address: 156.68,128, 186 Port: 56622
GMT 2019-07-22 11:51:23:495 Info: User selected COnboard Proxy IP 20,16, 13.82

GMT 2013-07-22 11:51:23:495 Info: User selected Ground Mode ID 345

GMT 2019-07-22 11:51:23:510 Info: Successfully activated support for HPEG.

HPEG Active

Figure 9 Inactive Destination

.. TReK HPEG

File View HPEG Options Help
Configuration: . Configure | Operational . Activate Deactivate

HPEG User: Enabled Increment: 41 Operational Mode: Flight Idle Check: Enabled Enable Disable

Ground Node ID: 345 HOSC DTN Mode Number: 65535 HOSC DTN Node IP Address: 192,168, 100,101 HOSC DTN Mode Port: 2014

Destination Enablement Forward Link Return Link Location Status  Ground Proxy [P Message Space Node ID
MylssPayload Enabled LOS AOS 155 Active  192,168.1.25 Successfully Initialized (0): Success!
SomewhereQverTheRainbow Disabled N/A N/A Icarus Inactive 2001

Start Session | | Stop Session
Message Area g X

GMT 2019-07-22 11:51:21:644 Info: Interfacing with EHS Build Version 31.1.2

GMT 2019-07-22 11:51:22: 191 Info: Accepted connection for Socket 1.2, 156,68, 128, 186.8819.3 IP Address: 156.68. 128,186 Port: 56622
GMT 2019-07-22 11:51:23:495 Info: User selected Onboard Proxy IP 20,16,13.82

GMT 2019-07-22 11:51:23:495 Info: User selected Ground Node ID 345

GMT 2019-07-22 11:51:23:510 Info: Successfully activated support for HPEG.

HPEG Active

Figure 10 Active Destination

5.4 How to Stop a Session with a Destination
This section describes how to stop a session with a destination.

1. The HPEG application must be configured and the HPEG service must be active.

2. Select an “Active” Destination in the HPEG area and push the Stop Session button.
This will send a request to the POIC to stop the session for that destination. If this is
successful, the destination’s Status column will show Inactive and the Ground Proxy
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IP column will be blank. You will also see a message in the Message column
indicating the status of your “Stop Session” request.

5.5 How to Enable and Disable the HPEG Idle Check

The Enable and Disable buttons on the HPEG toolbar can be used to control the HPEG
Idle Check. Ifyou disable the HPEG ldle check, you will not be prompted when your
HPEG session has been idle for a HOSC configured amount of time.

6 Details
This section covers various application details.

6.1 Configuration

The HPEG Configuration dialog contains two tabs: General and Firewall (NAT). The
General tab is used to provide information needed for TReK to communicate with the
HOSC about HPEG. The Firewall (NAT) tab can be used to enter configuration
information for locations using a firewall with network address translation.

6.1.1 General Tab
The General tab is shown in Figure 11. Eachfield is described below.

HPEG Configuration

HOSC Login Mame: | | | Browse... I

General Firewall (MAT)

Local IP Address: | | Browse. ..

Local Port: |aa 19 |

oK, Cancel

Figure 11 HPEG Configuration Dialog (General Tab)

HOSC Login Name
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This field should contain the name of an active HOSC Login Session that was created
using the TReK HOSC Login application. The Browse button can be used to view and
select a HOSC Login Name.

Local IP_ Address
This field should contain your local IP address.

Port
A TCP socket is created to send and receive HPEG information between TReK and the
HOSC. The Local IP Address and port are used to create this TCP socket.

6.1.2 Firewall (NAT) Tab
The Firewall tab is shown in Figure 12. Each field is described below.

Ml HPEG Configuration ? =

HOSC Login Mame: || Browse...

General Firewall (MAT)

[] Firewall In Use (Metwork Address Translation Meeded)

rewall TB Addre .
ewall IF AQdress,

vall Port:

i

Cancel

Figure 12 HPEG Configuration Dialog (Firewall Tab)

Firewall In Use (Network Address Translation Needed)
Check the “Firewall In Use” checkbox, if your location is using a Firewall with network
address translation.

Firewall 1P Address
The Firewall IP Address.

Firewall HPEG Port
The Port on the Firewall that should be used for HPEG traffic.

10
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6.2 HPEG Configuration and Status
This section describes the items in the main window HPEG toolbar.

HPEG User
This indicates if your user account is Enabled or Disabled for HPEG.

Increment
This displays the increment you are logged into.

Operational Mode
This displays the operational mode you are logged into.

Idle Check

This indicates if the HPEG Idle Check is Enabled or Disabled. If you push the Enable
button the Idle Check will be enabled. If you push the Disable button, the Idle Check
will be disabled. If the Idle Check is disabled, the POIC will not monitor the HPEG
sessions to determine if any have gone idle.

6.3 HPEG Messages

The HPEG Messages dialog is shown in Figure 13. Itis available from the HPEG menu.
This dialog displays HPEG messages associated with HPEG Destinations.

.. HPEG Messages ? *

GMT 2019-02-27 20:08:47 MylssPayload: Successfully Initialized (0): Success!

Clear

Figure 13 HPEG Messages

6.4 Application Messages

Various types of application messages are generated including information, progress,
warning, error, and debug messages. Information, warning, and error messages will be
displayed in the main window message area. All application messages are sent to the
Messages dialog shown in Figure 14. The Messages dialog can be configured to display
specific types of messages. By default, the Messages dialog will display information,
progress, warning, and error messages. Columns in the Messages dialog can be sorted by
clicking on the column header. The Messages dialog is available from the Options menu.

11
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4 Messages

Time Category Message 2
IGMT 2019-02-27 20:08:47:320 | Progress HPEG Proxy Init Message: MylssPayload Reason: Successf,.,
GMT 2019-02-27 20:08:47:318 Progress Successfully sent request to start session for HPEG destin,.,
GMT 2019-02-27 20:07:5%:181 Info Successfully activated support for HPEG,
GMT 2019-02-27 20:07:58:179 Progress The HPEG Ground Mode 1D was successfully set to 140731..,
GMT 2019-02-27 20:07:58:168 Info User selected Ground Mode 1D 345 W
Configure... Clear... Export...

Figure 14 Messages Dialog

Configure
The Configure button provides access to the Configure Messages dialog shown in Figure

15. This dialog provides access to preferences associated with messages. Display
preferences can be set to filter the types of messages (category) displayed in the
Messages dialog. Export Preferences control how the time tag is added to the filename
that is created when messages are exported. See the Export section for details.

.1 Configure Messages

Display Preferences

Info Frogress Warning Error [ | Debug

Export Preferences

[] when Exporting Messages Prepend the Timestamp to the Filename

Cancel

Figure 15 Configure Messages Dialog

Clear

The Clear button provides access tothe Clear Messages dialog shown in Figure 16. This
dialog provides two ways to clear messages in the Messages dialog. You can clear all the
messages or clear selected messages. Once you clear messages, the messages are
permanently deleted.

12
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. Clear Messages 7

(®) Clear All Messages
() Clear Selected Messages

Corcel

Figure 16 Clear Messages Dialog

Export

The Export button provides the capability to save all the application messages to a file.
When you push the Export button you will be prompted for a directory and filename.
Export will save all messages, not just the messages currently displayed in the Messages
dialog (i.e. the Display Preferences are not applied). The name you provide for the file
will be modified with a time tag that is added to the filename. The time tag indicates the
time the file was closed. The default is to append the time tag to the filename. For
example:

Filename Input: messages.txt
Filename Output: messages_2017-05-07_13~03~28.txt

If you would like to prepend the time tag to the filename you can set this preference in
the Configure Messages dialog. This would result in the following:

Filename Input: messages.txt
Filename Output: 2017-05-07_13~03~28_messages.txt

6.5 Advanced Settings

The Advanced Settings dialog provides access to configure several advanced settings.
The Advanced Settings dialog is shown in Figure 17.

Communication Timeout (miliseconds): | 10000 |

[ ] Log TReK HPEG Interface Messages
Log Directory: | C:fUsers/kirk

Log Filename: |trek_hpeg_interface_message_log. tit

Cancel

Figure 17 Advanced Settings Dialog

13
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Communication Timeout

You canset the timeout value used in communication with the Huntsville Operations
Support Center. It is unlikely there would ever be a need to modify this setting. The
timeout value canonly be modified when the HPEG service is inactive.

Log TReK HPEG Interface Messages

The TReK HPEG application provides the capability to log messages that are exchanged
between the TReK HPEG application and the HOSC HPEG software to a file. This
capability has been provided for troubleshooting purposes. Hopefully this is a feature
you will never need to use. If you check the Log TReK HPEG Interface Messages
checkbox, the messages that are exchanged betweenthe TReK HPEG application and the
HOSC HPEG software will be written to the log file specified. Message Logging will
start when the HPEG service is activated and stop if you uncheck the box or the HPEG
service is deactivated. Once a log file exists, any new messages will be appended to the
existing log file.

Log Directory
The Log Directory field should contain the absolute path to the directory where the log

file should be written.

Log Filename
The Log Filename field should contain the name to use for the log file.

6.6 Application Settings

The HPEG application saves application settings each time you exit the application. The
next time you run the application, the application will initialize with the previous settings.
Only one set of settings are saved. If you run multiple instances of the application, the
settings in the instance that is exited last will be saved. The following settings are saved:

Application Window Size
HPEG Port Entry

Firewall In Use Selection
Firewall 1P Address Entry
Firewall Port Entry

Firewall HPEG Port Entry
Configure Messages Selections
Advanced Settings

VVVVYVYYVYYVYY

7 FAQ and Troubleshooting

This section addresses Frequently Asked Questions and provides tips for troubleshooting
common gotchas.

No FAQs Yet.

14



